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TRANSFERRING YOUR LIBRARY ¢ niversity
SAFELY TO DOWNLOADS ON YOUR

WORK COMPUTER

BE WHAT YOU WANT TO BE

cqu.edu.au

On CQuUniversity staff computers everything on your Desktop or in your Documents folder will
automatically sync to your CQUniversity OneDrive storage. This is a problem for EndNote
because it relies on stable files paths to function properly. Files on OneDrive do not have
stable file paths. You will get an error message if your EndNote Library ends up in OneDrive.

EndNote can still live in your Documents on your personal / home computers provided that
they are not synced to OneDrive, but you'll need to relocate it to Downloads on your work
computer.

You need to maintain the connection between the .enl file and the .data folder, so the safest
way to move it is using a compressed copy.

After transferring your library, you'll need to check a few things and update the connections.

Part 1: Create a home to move your library to...........oeoiiiiiiii e, 2
Part 2: Make a compressed copy to safely transfer all records, file attachments and groups 2
Part 3: Open the compressed copy to set up a new working library ...............cccoieeene. 3
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Part 5: Reset PDF auto-import options if you had set automatic import folder for PDFs........ 6
Part 6: Reset the sync if your original library was synced with EndNote Online.................... 7

Change the sync library file path if EndNote is not updating automatically.............. 12



Part 1: Create a home to move your library to

IT have advised that EndNote should be living in your Downloads folder because it won’t be
automatically uploaded to OneDrive from there. If you are not comfortable having your library
in Downloads, the other option is a top level folder in C drive. (Never store an EndNote library

the EndNote program folder.)
1. Open the Downloads folder on your university computer
2. Click the folder icon to create a new folder

3. Rename it EndNote (or whatever name it had before)
& | | = | Downloads

Home Share View

&« v J’ > ThisPC » Downloads »

7 Quick access
[ Desktop
; Downloads
=| Documents

EndMote
&= Pictures

@ OneDrive

= This PC

Part 2: Make a compressed copy to safely transfer all records, file attachments

and groups
1. Open your current EndNote library
¢ If you are doing this to prepare for your files to be migrated to OneDrive, it's

your usual working copy, e.g. on U drive
o If your files have already been migrated, it will be on OneDrive

2. Open the File menu and select Compressed Library (.enlx) ...

3. Check that Create, With File Attachments and All References in Library are selected in
the Compressed library window. Click Next

Compressed Library (.enlx) @
) Create! @) With File Attachments
Create & E-mail Without File Attachments
@) All References in Library: Sam's EndMote Library.enl

Selected Reference(s)

All References in Group/Group Set: | My Groups

Mext ] | Cancel
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4. A Save Compressed Library (.enlx) window will open. Navigate to the EndNote folder
in Downloads on your computer. Open that folder.

&) Save Compressed Library (.enbd
€« A

Organize +  New folder

~
@ OneDrive Name

[ This PC
1 2D Objects
I Desktop
[£] Documents
J Downloads
b Music v €

» ThisPC » Downloads » EndMote

Date medified

No items match your search,

v O Search EndMote

File name: | Sam's EndNote Library.enle

A Hide Folders

Save as type:  EndNote Compressed Library (*.enh)

Save

Cancel

5. Click Save. The compressed copy of your library will appear in the Endnote folder as

an .enlx file

| 1] = | EndMote
- Home Share View
<« v » This PC » Downloads » EndMote
~
@ OneDrive m
& This PC —
v
J 2D Objects ‘?
[ Desktop '
= D t Sam's
|=| Documents EndNote
‘ Downloads Library.enkx
b na._:o

6. Close the original copy of your library.

7. While we've got you thinking of compressed copies, make at least 2 copies of the
compressed library you've just created and save them to 2 other locations. Then you'll

have the 3 back-up copies we’re always asking you to keep.

Part 3: Open the compressed copy to set up a new working library

1. Go to the new EndNote folder in Downloads

| | = | EndNote

€ - v

@ OneDrive

[ This PC
J 3D Objects
[ Desktop
= Documents
* Downloads
J’a Music

= Pictures

Share WView

» ThisPC » Downloads » EndMote

=1
7

sl 4
Sam's

EndMote
Library.enlkx

M
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2. Double click on the compressed copy of your library to open it. EndNote will extract the
library and index the pdfs.

Extracting Sam's EndMote Library.enlx...

et

: Cancel

If you go back to the EndNote folder in downloads you will see that there are now 3 icons /

files

o The .enlx file — the compressed copy will remain here even though you have opened a

new copy of the library from it.
e The .enl file which is your new working library.
e The .Data folder which contains the file attachments and information about groups and

other settings

vl + | EndMote
- Home Share View
- v » ThisPC » Downloads > EndMNote
L)
g EN | [EN |
B This PC =
. & ”
3 30 Objects -~ E
B Desktop ' '
4| Documents Sam's Sam's Sam's
. EndMote EndMote EndMote
4 Downloads Library.Data Library.enl Library.enlx
B hdiecic

3. Open the .enl file and do a quick check to make sure that the library is working.

4. When you’re done that, create a new subfolder called Back-ups.
Move the compressed copy to it.

|2] = | EndMote

€ v
@ OneDrive

[ This PC
) 3D Objects
[ Desktop
|i5-'| Documents
‘ Downloads
J‘! Music

Share View

» ThisPC » Downloads » EndMote

)

Backups

-
-

i

Sam's EndMote Trash.Data

Library.Data

EN
4

Sam's EndMote
Library.enl

Page 4 of 13



Part 4: Reset the connections between your working library and your Word

documents

Now that you’ve transferred your library to its new home on the hard drive of your computer,
the file paths have changed. It's a good idea to update the citations and bibliography in each of
your working documents to make sure that the connections are still working. Work one

document at a time.

1. Open your new working EndNote library

Open the document
Go to the EndNote toolbar in Word

Open the Convert Citations and Bibliography menu.

Layout

Styles |APA Tth

B
=

W]

References

l_E,[ Update Citations and Bibliography

Mailings Review View

- ﬁ:ﬁ Categorize References ~
Instant Formatting is Off =

%, Convert Citations and Bibliography ~
Convert to Unformatted Citations I
Convert to Plain Text

Convert Reference Manager Citations to EndNote

Developer

Help

Export to EndMote -
l]mlManu:cript Matcher

—
= Preferences

Toals

EndNote X9

(7

Help

Convert Word Citations to EndMote

5. Select Convert to Unformatted Citations. Your bibliography will disappear, and the
citations will look something like this {Grey, 2010}. This is supposed to happen.

6. Select Update Citations and Bibliography in the EndNote toolbar.

AutoSave (@ Off)

¥

Home Insert Design Layout References Mailings Review
[1) EN, Go to EndNote Style: |APA 6th edited -
Insert E", Edit & Manage Citation(s) LE,' Update Citations and Bibliography
nse

Cita;ion - Er:g Edit Library Reference(s)

Citations

B2, Convert Citations and Bibliography -
Eibliography
Update Citations and Bibliography & 7 E

\PTERS

Format your document accerding
to the rules of the selected style.
This replaces any temporary
citations with formatted citations
and inserts a bibliegraphy at the
end of the document.

View

@Categorize References -
Instant Formatting is Off -

Developer

ul

Help EndNote X9

Export to EndMote =
l]ﬂl:'l Manuscript Matcher

— Help
== Preferences
Tools
11 12 13 14 15 1§
c\\/
BEWHAT YOU

7. This will prompt EndNote to work through your citations and check that they all match
the records in your library and refresh the connections between your library and that
document. If there are any that don’t match, EndNote will alert you of potential matches
so you can correct them. It will rebuild your bibliography and return the citations to their

normal format.
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8. Save and close that document once the update is complete.

9. Open the next document, update the citations and bibliography, save and close.

10. Repeat until you’ve updated them all.

Part 5: Reset PDF auto-import options if you had set automatic import folder for

PDFs

1. Create a new folder in the EndNote folder in downloads, e.g. Articles2import

| I~ = | EndNote

- Home Share View

~
@ OneDrive

[ This PC
J 2D Objects
[ Desktop

# Downloads
b Music

€« - 1 » ThisPC » Downloads »

|2 Documents ArticlesZimport

| ’ ‘
Sam's Sam's
EndMote EndMate
Library.enl Library.enlx

2. Open the Edit menu in EndNote

3. Select Preferences

4. Go to PDF Handling in the left-hand menu

5. Click the Select Folder button in the PDF Auto Import Folder section

6. Navigate to the folder you’ve just created (in EndNote in Downloads)

Browse For Folder

PDF Auto Import Folder

X

= This PC
J 3D Objects

[ Desktop

[=| Documents
v ‘ Downloads

v EndMote

Articles2import

J’i Music

&= Pictures

m Videos

g Windows (C)
L4

Make Mew Folder

Cancel

7. Select that folder and click OK.
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8. Back in the Preferences window, click Apply, then OK.

EndNote Preferences X
. Change Case
. Display Fields PDF Autto Renaminy g Options
Display Fonts (O Dont Rename
- Duplicates
Find Full Text O Author + Year + Title
- Folder Locations @) Author + Title
- Formatting O Author + Year
Libraries
Moo anding e
Read / Unread O Custom
. Reference Types
- Sorting
Spell Check
- Sync Note: Filenames may be up to 50 characters long
Temporary Citations
- Term Lists
- URLs & Links POF Auto Import Folder

Enable automatic importing

|u EndNote'\AticlesZimport Select Folder

EndNote Defauits Revert Panel Cancel A

9. The new folder will be set as the one to import articles from.

Part 6: Reset the sync if your original library was synced with EndNote Online
NOTE: You don’t need to do this if your original library was not synced to EndNote online.
Your new working library is in a new location. The original sync settings will no longer work
because the file path has changed. You've made a compressed copy of your library. Keep that

as a back-up.

You will need to work with your EndNote on your computer and EndNote online for this
process.

The time it takes for the new sync will depend on the size of your library. If you have a large
library, it might be a good idea to start in the morning. Resetting the sync is not something to

start just before you leave for the day.

Working in the desktop version of EndNote
1. Open the new working library

2. Open the Edit menu
3. Select Preferences

4. Go to Sync in the left-hand menu.
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5. Untick the Sync Automatically box.

EndMote Preferences

- Change Case
Display Fields

- Display Fonts
Duplicates

- Find Full Text

- Folder Locations
Formatting

- Libraries
PDF Handling

- Read / Unread

- Reference Types

- Sorting

- Spell Check
Sync

- Temporary Citati

- Term Lists

-~ URLs & Links

EndMote Defaults

and enable Sync

Enable Sync

EndNote Account Credentials

Synchronize your data with your EndNote account. Leam more

Upgrade or create your two-year EndMNote account to get the latest features

E-mail Address:

|s.taff@cau edu.au

Password: |

Sync this EndNate Library

ons
Downloads'EndMNote' Sam’s EndNote Library enl
Revert Panel Cancel

Apply

6. Click Apply then OK.
7. Close EndNote.

Working in EndNote Online
1. Log into your EndNote On

line account.

2. It will open at My References

3. Delete all references except for those in shared groups and Researcher ID groups.

a. Select the group from the list on the left

b. Tick the All box
c. Click Delete

o .
S Clarivate | EndNote
My References Collect Qrganize Format Match Options Downloads
Quick Search Colour
5 Search for
= Show 50 v WA pge[t |oft Go P M
E8  in[All My References ~ ow 0 per page
@
2 Search
B [Opage Copy To Quick List | Delete | Remove from Group
My References n
MVMV —— Authort Year Title | Move Checked References from All My References to thetrash |
[Unfiled] (0) 1700 Pattern book of silks and damasks
Quick List (0) Added to Library: 01 May 2019 Last Updated: 22 Aug 2019
Trash (0) 'E)_ﬂlée Link= Go to URL
W My Groups L
Ackermann, Rudolph 1809~1828 The Repository of arts, literature, commerce, manufactures, fashion|
Contemporary literature (4) Added to Library: 01 May 2019 Last updated: 22 Aug 2019
Cosmetics & medicines (3} Online Link+ Go to URL
Costume & accessories (21) .
Dancing (9} Adrosko, Rita 1 1971 Natural dyes and home dyeing: a practical guide with over 150 recig|
EndNote / workshops (28) Added to Library: 01 May 2019 Last Updated: 27 Nov 2019
Essays (4) [
Food & drink (2) Davidson, Hilary 2015 Reconstructing Jane Austen's Silk Pelisse, 1812-1814
Furniture, architecture, desi... (3} Costume
History / Philosophy (3) Added to Library: 01 May 2019  Last Updated: 22 Aug 2019
JA Biographical (8) Online Link+ Go to URL
Jane's wrilings (16) L 14
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4. Delete all groups except for Groups Shared by Others and ResearcherID groups.

a. Open the Organise menu
b. Select Manage My Groups
c. Click the Delete button for each group name to delete the group.
d. Click OK in the confirmation window that pops up
C clarivate | EpdNote
My References Collect Organize Format Match Options Downloads

Manage My Groups

Number of

Manage My Groups | Others’ Groups

Find Duplicates

My Groups+ S Share

Colour 11 O m Rename Delete
Contemporary hterature 4 0O Rename Delete |
Cosmetics & medicines 30 — Dy, Delete group
Costume & accessories 21 O [T — Rename Delete

5. Empty the Trash.
a. Select the Trash group.
b. Click Empty.

Manage Atachments

6. Your EndNote Online version is now clear and ready for you to reset your sync to.

Working in the desktop version of EndNote

1. Open your new working library on your computer again.

Empty the Trash group. You don’t want to waste time syncing records you don’t want.

Open the Preferences window again and go to the Sync section (Edit > Preferences

2.
3.
- Sync)
. EndMote Preferences
4. Add the following to the end of your m—
. ange Lase
email address #lresetLocalSync - Disply icds
Duppllc);tes
. ) - Find Full Text
5. It's case sensitive so it must match " FolderLocetions
exactly Libraries
PDF Handling
. Read / Unread
- Reference Types
6. No spaces between the last o
character of your email address i _
- Temporary Citations
- Term Lists
and the # URLs&Ifmks
7. Click Apply then OK.
EndNote Defaults

X
Synchronize your data with your EndNote account. Leam more
Upgrade or create your two-year EndMote accourt to get the latest features
and enable Sync.
Enable Sync
EndNote Account Credentials
E-mail Address |s taff @cqu.edu.auflreset Local Sync
Password [feesee
Syne this EndMote Library
U:\EndMote \End...\Samantha’s EndMote Library.enl
[ Sync Automatically
Revert Panel Cancel HApply
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8. A message will appear

“A Sync library can be linked to only one account. Do not proceed
unless you intend to break the link to the original account.”

Click OK

9. A second message will appear:

“Your local sync state has been reset. Please re-enter your E-Mail

Address, restart EndNote, and sync again”.

Click OK.

10. Close EndNote.

Still in the desktop version of EndNote
1. Open EndNote again.

2. Open the Preferences window again and go to the Sync section (Edit > Preferences

- Sync)

3. Clear all of the text from the Email Address box and retype your email address.

EndNote Preferences

Change Case

- Display Fields

- Display Fonts
Duplicates

- Find Full Text
Folder Locations

- Formatting

- Libraries

- PDF Handling

- Read / Unread
Reference Types

- Sorting

- Spell Check

- Sync

- Temporary Citations

Term Lists
-~ URLs & Links

EndMote Defaults

and enable Sync.

Enable Sync

EndNote Account Credentials

Synchronize your data with your EndMote account. Leam more

E-mail Address: |s taff @cqu.edu.au

Password: |

Sync this EndNote Librany

Upgrade or create your two-year EndMote account to get the latest features

Downloads‘\EndNote’ Sam’s EndNote Librany.enl

[ Syne Automatically

Revert Panel Cancel

Apply

*

4. Check that that the new working library is selected in the Sync this EndNote Library

box

5. Click OK. This closes the preferences window and saves this setting.

6. Close EndNote
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Deep breath. The next few steps are the last ones. Still in the desktop version of
EndNote
1. Click the Sync Library icon in the Tool bar in EndNote

™, Fille Edit References Groups Tock Window Help 1
rJ I‘;‘I '-f| Humbered = | [& |_§_' \*Ti \'._z "I\I vl':, _!!-l '_=_A!.- -\']' B ! 7 ol
My Library || € Re. Author Year  Title

All References (25) 2 Bardi, Carla; Momis.. 2012 Chocolate: 140 de

2. Go to Sync Configuration in the Groups panel and click Sync Now (Endnote 20). Click
the Sync Library icon in the Tool bar in EndNote (EndNote X9)

3. Your new working library will now be prompted to sync to EndNote online. This
message will appear again:
“A Sync library can be linked to only one account. Do not proceed unless you intend
to break the link to the original account.”
Click OK.

4. You will be prompted to create a back-up. You created a compressed copy at the
beginning of this process, and possibly have 2 more copies of it if you took the earlier
hint, but it won’t hurt your library to create another compressed back up copy at this
point if you want to.

EndNote will start syncing your new working library. If your library is large, this process
could take some time.
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Change the sync library file path if EndNote is not updating automatically
When you change your sync library, the file path in preferences should update automatically. If
it doesn’t, you will need to edit the file path.

On a Windows PC
1. Close EndNote.

All Apps Documents
—

Best match

i+ regedit.exe

Run command

2. Click on the magnifying glass in the computer task bar and
type regedit.exe into the search box. Hit Enter.

Search the web

L regedit.exe - see web res

3. Click regedit.exe in the results

£ regedit.exe

4. Click to expand the HKEY_CURRENT_USER to show subfolders. Continue opening
folders to show subfolders as you navigate to Software >> IS| ResearchSoft >>
EndNote >> Preferences

B Registry Editor
File Edit View Favontes Help
Computer\ HKEY_CURRENT _USER\Software'IS! ResearchSoft\ EndMote\Preferences
~ Bl Computer # || Mame Type Data
a 28| LibraryWindow.... REG_MULTI_SZ T
34 LibraryWindow._.. REG_OWORD 00000000 (0
3| LibraryWindow.... REG_DWORD CoeOO000F (223)
Control Pand -.. REG_DWORD 00000032 (50)
ks sitabob .. REG_DWORD (0000Taf (431)
FUDC . REG_DWORD CoeDOQOO00Z (3)
Keyboard Layout . REG_DWORD 0x00000182 (386)
Network 73 LibraryWindow.... REG_DWORD OxD000004 (75)
Printers b |ibraryWindew.... REG_MULTI_SZ F
w Soltware 03 OpenlibsAtStarup REG_DWORD 00000001 (1)
Adobe A% PdfAutolmpentE.. REG_MULTI_SZ l
AppDatalow ab| paffutolmpontF... REG_MULTI_SZ Ci\Users\holcrofs\Downloads\EndMotel Aticlesdi...
Chaomaun 7% PdifutoRensme.. REG_DWORD 000000002 (2)
Cisco Systems, Inc. ) PrafsSrring(D02)  REG_MIULTI_SZ AP Teh.ene
Classes 28| PrefsString(058)  REG_MIULTI_SZ T
Chients 35| prefsString(D61)  REG_MULTI_SZ T
Conoant 5% PrefaString(064)  REG_DWORD 0000004 (13)
Expreas Metrix 38| ReferenceWindo.. REG_MULTISZ T
m:m; 13 ReferenceWindo.. REG_DWORD 000000301 (345)
ot 1% ReferenceWinda... REG_DWORD 0000001 90 (300)
& IS! ReseacchSolt A%/ 5BC FootMame  REG_MULTI SZ Tahema
s EndNote AB|SBC_QutputStyle  REG_MULTI_SZ Annctated
Addin 35| ShowGettingSta.. REG_MULTI_SZ 3
Cite While You Write b SorFields(000)  REG_MULTI_SZ data=0000050002000000000000K000000600000...
Favorite Connections a8 SyncAutomatica... REG_MULTI_SZ F
Favorite Filters 28| SyncLastErmor REG_MULTI_SZ
Favonte Styles A8 SyncLastErrorh.,.  REG_MULTI_SZ Intemnal Ervar
Ignoreversacns 4 _ REG_MULTI_SZ pS2aateauepdSlectdbpStwaveesaplaidnd
: hlaaa'\ ErdPlote ibrany’ Samantha’s Endiote ...
3 174 09 5b 01 5 b9 3 9b De 81 of 21 6.
" a8 SyncUserMarme . cqu.edu.auiresetlocalSync
Recent Libranes 48] Window Placen |1.622.45,1561,979
Recent 5P Files %) Window Placen [elste }1,2414,154,3210,619
Settings v || ¥ Window Placen  Rename 1,482 265 1838.775

5. Right click on SyncLibraryPath to bring up the menu. Choose Modify. This opens an
Edit Multi-String window so you can edit the file path to match the new library location.
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6. Next you’ll need the exact file path of the new location of your library. Open your
Downloads folder and navigate to the folder that your EndNote library is now in.

10.

11.

12.

| < | Library
=1 o+
<« v Ci\Users\username \Downloads\EndMote\ Library g K¢

~
A Name

# Quick access
[ Desktop
4 Downloads
== Documents
=] Pictures

v <

I arenm mlane amd bazrhine mmatarisle

2itemns

Samantha's EndMote Library.Data
Y Samantha's EndMate Library.enl

Click in the address bar to bring up the file path.
Copy the file path from the file path for the folder
from the address bar of the file explorer window.

Paste this file path to the new folder into the Edit
Multi-String window in place of the old path. Keep
the library name and make sure that there is a

backslash between the folder name and the
library name. Click OK.

Open EndNote
Open the Edit menu and select Preferences.

Go to Sync in the left-hand menu, and check that
the file path has updated

Go back to the Reset Sync instructions and try
again from where you left off.

Book an online Ask a Librarian session online.

Edit Multi-String e

Value name
SyncLlibraryPath

Value data:

C:\Users\username\Downloads\EndNote\Library\Sam's EndNo [

>

Cancel

EndMote Preferences

Change Case
Display Fields
Display Fonts

. Duplicates
Find Full Text
Folder Locations
Formatting
Libraries

- PDF Handling
Read / Unread

- Reference Types
Sorting
Spell Check
Sync
Temperary Citatiens

- Term Lists.

URLs & Links

EndNote Defaults

Synchronize your deta with your EndNote accourt. Leam more

Upgrade or create your two-year EndNote account to get the latest features
and enable Sync
Enable Symc

EndNote Account Credentials

[s omeone @oau edu au
Password ==

Syrc this EndNote Library

Email Address.

‘c Users\ username. .\Sam's EndNate Library enl |

O Sync Automatically

Revert Panel

If something went wrong and you need help with one or more of the parts of this
process:

Or contact the vendor’s technical support staff if the library is closed and you need
help before it opens again.
https://support.clarivate.com/Endnote/s/?language=en_US
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